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Overview  


•  Sources of Overhead in Parallel Programs  


•  Performance Metrics for Parallel Systems  
  
•  Scalability of Parallel Systems and Algorithms 
 
•  Analysis of Parallel Programs  


Some material from A.Grama, A. Gupta, G. Karypis, V.Kumar ``Introduction to Parallel Computing'',  
Addison Wesley, 2003,  http://www-users.cs.umn.edu/~karypis/parbook/ 
 







Parameters  
•  A sequential algorithm is evaluated by its runtime (in 


general, asymptotic runtime as a function of input size).  


•  The asymptotic runtime of a sequential program is 
identical on any serial platform.  


•  The parallel runtime of a program depends on the input 
size, the number of processors, and the communication 
parameters of the machine.  


•  An algorithm must therefore be analyzed in the context 
of the underlying platform.  


•  A parallel system is a combination of a parallel algorithm 
and an underlying platform.  







Parameters  
•  A number of performance measures are intuitive.  


•  Wall clock time - the time from the start of the first 
processor to the stopping time of the last processor in a 
parallel ensemble. But how does this scale when the 
number of processors is changed of the program is 
ported to another machine altogether?  


•  How much faster is the parallel version? This begs the 
obvious follow up question – what is the baseline serial 
version with which we compare?  







Sources of Overhead in Parallel 
Programs  


•  If I use two processors, shouldn’t my program run twice as fast?  
•  No - a number of overheads, including wasted computation, 


communication, idling, and contention cause degradation in 
performance.    


 The execution profile of a hypothetical parallel program executing on 
eight processing elements. Profile indicates times spent performing 
computation (both essential and excess), communication, and idling. 


   







Sources of Overheads in 
Parallel Programs  


•  Interprocess interactions: Processors working on any 
non-trivial parallel problem will need to talk to each other.  


•  Idling: Processes may idle because of load imbalance, 
synchronization, or serial components.  


•  Excess Computation: This is computation not performed 
by the serial version. This might be because the serial 
algorithm is difficult to parallelize, or that some 
computations are repeated across processors to 
minimize communication.  







Performance Metrics for Parallel Systems: 
Execution Time  


•  Serial runtime of a program is the time elapsed between 
the beginning and the end of its execution on a 
sequential computer.  


•  The parallel runtime is the time that elapses from the 
moment the first processor starts to the moment the last 
processor finishes execution.  


•  We denote the serial runtime by   and the parallel 
runtime by TP . 







Performance Metrics for Parallel 
Systems: Total Parallel Overhead  


•  Let Tall be the total time collectively spent by all the processing 
elements.  


•  TS  is the serial time.  


•  Observe that Tall  - TS is then the total time spend by all processors 
combined in non-useful work. This is called the total overhead.  


•  The total time collectively spent by all the processing elements  
Tall = p TP   (p is the number of processors).  


•  The overhead function (To) is therefore given by   


                To = p TP - TS          (1) 







Performance Metrics for Parallel 
Systems: Speedup  


•  What is the benefit from parallelism?  


•  Speedup (S) is the ratio of the time taken to solve a 
problem on a single processor to the time required to 
solve the same problem on a parallel computer with p 
identical processing elements. 


•      Speedup  Sp=Ts/Tp  







Performance Metrics: Example  
•  Consider the problem of adding n numbers by using n 


processing elements.  


•  If n is a power of two, we can perform this operation in 
log n steps by propagating partial sums up a logical 
binary tree of processors.  







Performance Metrics: Example  


 Computing the globalsum of 16 partial sums using 16 processing 
elements .  Σj


i denotes the sum of numbers with consecutive labels 
from i to j.  







Performance Metrics: Speedup  
•  For a given problem, there might be many serial 


algorithms available. These algorithms may have 
different asymptotic runtimes and may be parallelizable 
to different degrees.  


•  For the purpose of computing speedup, we always 
consider the best sequential program as the baseline.  







Performance Metrics: Example 
(continued)  


•  If an addition takes constant time, say, tc and 
communication of a single word takes time ts + tw, we 
have the parallel time  


 TP = Θ (log n) 
 


•  We know that TS = Θ (n) 


•  Speedup S is given by S = Θ (n / log n) 







Performance Metrics: Speedup 
Bounds  


•  Speedup can be as low as 0 (the parallel program never 
terminates).  


•  Speedup, in theory, should be upper bounded by p - 
after all, we can only expect a p-fold speedup if we use 
times as many resources.  


•  Usually                            0< Sp < p 
•  A speedup greater than p is possible only if each 


processing element spends less than time TS / p solving 
the problem.  


•  In this case, a single processor could be timeslided to 
achieve a faster serial program, which contradicts our 
assumption of fastest serial program as basis for 
speedup.  







Performance Metrics: Efficiency  
•  Efficiency is a measure of the fraction of time for which 


a processing element is usefully employed  


•  Mathematically, it is given by  


        
             =      (2) 


 
•                                0  <   E  <  1 
•  Following the bounds on speedup, efficiency can be as 


low as 0 and as high as 1.  







Performance Metrics: Efficiency 
Example  


•  The speedup of adding numbers on processors is given 
by  


•  Efficiency is given by  
  


 
     


                                         = 
     
     







Effect of Granularity on 
Performance  


•  Often, using fewer processors improves performance of parallel 
systems.  


•  Using fewer than the maximum possible number of processing 
elements to execute a parallel algorithm is called scaling down a 
parallel system.  


•  A naive way of scaling down is to think of each processor in the 
original case as a virtual processor and to assign virtual processors 
equally to scaled down processors.  


•  Since the number of processing elements decreases by a factor of  
n / p, the computation at each processing element increases by a 
factor of n / p.  


•  The communication cost should not increase by this factor since 
some of the virtual processors assigned to a physical processors 
might talk to each other. This is the basic reason for the 
improvement from building granularity.  







Granularity: Example  
•  Consider the problem of adding n numbers on p processing 


elements such that p < n and both n and p are powers of 2.  


•  Use the parallel algorithm for n processors, except, in this case, we 
think of them as virtual processors.  


•  Each of the p processors is now assigned n / p virtual processors.  


•  The first log p of the log n steps of the original algorithm are 
simulated in (n / p) log p steps on p processing elements.  


•  Subsequent log n - log p steps do not require any communication.  







Granularity: Example 
(continued)  


•  The overall parallel execution time now is  
 Θ ( (n / p) log p).  


 
•  The cost is Θ (n log p), which is asymptotically higher 


than the Θ (n) cost of adding n numbers sequentially. 
Therefore, the parallel (algorithm) system is not cost-
optimal.  







Granularity: Example 
(continued)  


 Can we build granularity in the example in a cost-optimal fashion?  
•  Each processing element locally adds its n / p numbers in time     Θ (n / p).  
•  The p partial sums on p processing elements can be added in time Θ(n /p). 
 


  
 
 
 
 
 


  
 
A cost-optimal way of computing the sum of 16 numbers using four processing 


elements.  







Granularity: Example 
(continued)  


•  The parallel runtime of this algorithm is  
       
        
        (3) 


•  The cost is  
  
 







Scaling Characteristics of Parallel 
Programs  


•  The efficiency of a parallel program can be written as:  


  
  
  
 or        (4) 
 


 
•  The total overhead function To  is an increasing function of p  .  







Scaling Characteristics of Parallel 
Programs  


 
•  For a given problem size (i.e., the value of TS  remains 


constant), as we increase the number of processing 
elements, To increases.  


•  The overall efficiency of the parallel program goes down. 
This is the case for all parallel programs.  







Scaling Characteristics of 
Parallel Programs: Example  


 •  Consider the problem of adding   numbers on   processing elements.  


•  We have seen that: 
 
  


   =          (5) 
      
         
    =          (6) 
  
            
    =          (7) 







Scaling Characteristics of Parallel 
Programs: Example (continued)  


  Plotting the speedup for various input sizes gives us:  
 
 
 
 
 
 
 


   
 Speedup versus the number of processing elements for adding a 
list of numbers.  


 
 Speedup tends to saturate and efficiency drops as a consequence 
of Amdahl's law 







Scaling Characteristics of 
Parallel Programs  


•  Total overhead function To is a function of both problem size Ts and 
the number of processing elements p. 


  
•  In many cases, To grows sublinearly with respect to Ts.  


•  In such cases, the efficiency increases if the problem size is 
increased keeping the number of processing elements constant.  


•  For such systems, we can simultaneously increase the problem size 
and number of processors to keep efficiency constant.  


•  We call such systems scalable parallel systems.  







Scalability 
 


•  For a given problem size, as we increase the number of 
processing elements, the overall efficiency of the parallel 
system goes down for all systems. 


•  For some systems, the efficiency of a parallel system 
increases if the problem size is increased while keeping 
the number of processing elements constant. 







Scalability 
 


•  What is the rate at which the problem size must increase 
with respect to the number of processing elements to 
keep the efficiency fixed? 


•  This rate determines the scalability of the system. The 
slower this rate, the better. 


•  Before we formalize this rate, we define the problem size 
W as the asymptotic number of operations associated 
with the best serial algorithm to solve the problem. 







Isoefficiency Metric of Scalability  
•  We can write parallel runtime as:  


    
                (8) 
 


•  The resulting expression for speedup is  
 


     
 


               (9) 
 


•  Finally, we write the expression for efficiency as  
 


           







Isoefficiency Metric of Scalability  
 •  For scalable parallel systems, efficiency can be maintained at a fixed value 


(between 0 and 1) if the ratio To / W is maintained at a constant value.  
•  For a desired value E  of efficiency,  


 
                          


 
 


            (11) 
 


•  If  K = E / (1 – E)  is a constant depending on the efficiency to be 
maintained, since To is a function of W and p, we have  
 
              (12)


  







Isoefficiency Metric of Scalability  
•  The problem size W can usually be obtained as a 


function of p by algebraic manipulations to keep 
efficiency constant.  


•  This function is called the isoefficiency function.  


•  This function determines the ease with which a parallel 
system can maintain a constant efficiency and hence 
achieve speedups increasing in proportion to the number 
of processing elements  







Other Scalability Metrics  
•  A number of other metrics have been proposed, dictated 


by specific needs of applications.  


•  For real-time applications, the objective is to scale up a 
system to accomplish a task in a specified time bound.  


•  In memory constrained environments, metrics operate at 
the limit of memory and estimate performance under this 
problem growth rate.  







Amdahl’s Law 
Fixed problem size 


In many practical applications the computational 
workload is fixed: 
Two parts for the problem with size W : 
sequential and parallel part 
 
W = αW + (1- α)W 
 
Sp = W / (αW + (1- α)(W/p)) 
 
= p / (1 + (p - 1) α) → 1 / α as p → ∞ 
 
Speedup is limited by 1 / α  
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Lecture Plan: 


Day 1 


Session 1 / 10:00 am – 1:00 pm 


1. Introduction to parallel algorithms design and performance 
parameters (1 h) 


2. Tareador: tool to analyze potential parallelism and its inhibitors (2 h) 


3. Practical: simple heat diffusion application 


Session 2 / 2:00pm – 5:00 pm 


1. Introduction to Paraver: tool to analyze and understand performance 


2. Practical: hybrid MPI/OpenMP trace analysis 







Lecture Plan: 


Day 2 


Session 1 / 10:00 am - 1:00 pm 


1. Introduction to MPI: Overview of MPI 


2. Point-to-point communication, collective communication 


3. Practical: How to compile and run MPI applications, distributed matrix 
computations (matrix multiply or/and heat equation) 


Session 2 / 2:00 pm - 5:00 pm 


1. Blocking and non-blocking communications 


2. Communicators, Topologies 


3. Practical: Distributed matrix computations (same examples as in 
session 1) 







Lecture Plan: 


Day 3  


Session 1 / 10:00 am - 1:00 pm 


1. MPI I/O issues, Error handling, Parallel libraries 


2. Scalability, xSim and Dimemas simulator 


3. Practical: Scalability simulations using xSim and Dimemas 


Session 2 / 2:00 pm - 5:00 pm 


1. Practical: Scalability simulations using xSim and Dimemas (cont.) 


2. Outlook - Fault tolerance, FT-MPI, MPI 3.0 







Lecture Plan: 


Day 4  


Session 1 / 10:00am – 1:00 pm 


1. Shared-memory programming models, OpenMP fundamentals 


2. Parallel regions and work sharing constructs 


3. Synchronization mechanisms in OpenMP 


4. Practical: heat diffusion 


Session 2 / 2:00pm – 5:00 pm 


1. Tasking in OpenMP 


2. Programming using a hybrid MPI/OpenMP approach 


3. Practical: Multisort (tasking) and heat diffusion (hybrid MPI/OpenMP) 







Lecture Plan: 


Day 5  


Session 1 / 10:00 am – 1:00 pm 


1. Introduction to the OmpSs programming model 


2. Programming using a hybrid MPI/OmpSs approach 


3. Practical: TBD 


 


END of COURSE 







1st Lecture Outline: 


 


•  Introduction   


•  Parallel Algorithms and Parallelisation 
Techniques  


•  Performance Evaluation and Performance 
Metrics  







Top 500 list – trends and performance 







Top 500 - trends 







Top 500 - trends 







Scalable Algorithms: Motivation/Drivers 


•  Bridging the Performance Gap while dealing with 
Hybrid Architectures 


•  Increased Scalability  


•  Highly fault-tolerant  and fault-resilient algorithms 


•  Need to calculate with higher precision without 
restart 


•  Need to tackle efficiently Grand Challenges 
problems  







Challenges 


  To achieve excellent results scalability 
at all levels would be required: 


 
• Mathematical models level 
• Algorithmic level 
• Systems level 
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Parallel Algorithms and Concurrency  


•  Parallel Algorithms  


•  Tasks and Decomposition  


•  Processes and Mapping  


•  Processes Versus Processors  


•  Decomposition Techniques  


•  Recursive Decomposition  


•  Recursive Decomposition  


•  Exploratory Decomposition  


•  Hybrid Decomposition  


•  Characteristics of Tasks and Interactions  


•  Task Generation, Granularity, and Context  


•  Characteristics of Task Interactions.  


Some Material from A.Grama, A. Gupta, G. Karypis, V.Kumar ``Introduction to Parallel Computing'',  Addison Wesley, 2003, http://www-users.cs.umn.edu/~karypis/parbook/	




	









Mapping 


•  Mapping Techniques for Load Balancing  


•  Methods for Minimizing Interaction Overheads  


•  Parallel Algorithm Design Models  


 







Decomposition, Tasks, and Dependency Graphs 


• The first step in developing a parallel algorithm is to 
decompose the problem into tasks that can be executed 
concurrently  


• A given problem may be decomposed into tasks in 
many different ways.  


• Tasks may be of same, or different sizes.  


• A decomposition can be illustrated in the form of a 
directed graph with nodes corresponding to tasks and 
edges indicating that the result of one task is required 
for processing the next. Such a graph is called a task 
dependency graph.   







Multiplying a Dense Matrix with a Vector 


Computation of each element of output vector y is independent of other elements. Based on 
this, a dense matrix-vector product can be decomposed into n tasks. The figure highlights the 


portion of the matrix and vector accessed by Task 1. 	


	




Observations: While tasks share data (namely, the vector b ), they do not have any control 
dependencies - i.e., no task needs to wait for the (partial) completion of any other. All tasks 
are of the same size in terms of number of operations. Is this the maximum number of tasks we 
could decompose this problem into? 	









Granularity of Task Decompositions  


•  The number of tasks into which a problem is decomposed 
determines its granularity.  


•  Decomposition into a large number of tasks results in fine-grained 
decomposition and that into a small number of tasks results in a 
coarse grained decomposition.  


A coarse grained version of the dense matrix-vector product example. Each 
task in this example corresponds to the computation of p=3 elements of 
the result vector. 	









Degree of Concurrency  


•  The number of tasks that can be executed in parallel is the degree 
of concurrency of a decomposition.  


•  Since the number of tasks that can be executed in parallel may 
change over program execution, the maximum degree of 
concurrency is the maximum number of such tasks at any point 
during execution. What is the maximum degree of concurrency of 
the database query examples?  


•  The average degree of concurrency is the average number of tasks 
that can be processed in parallel over the execution of the program. 
Assuming that each tasks in the database example takes identical 
processing time, what is the average degree of concurrency in each 
decomposition?  


•  The degree of concurrency increases as the decomposition 
becomes finer in granularity and vice versa.  


 







Limits on Parallel Performance  


•  It would appear that the parallel time can be made 
arbitrarily small by making the decomposition finer in 
granularity.  


• There is an inherent bound on how fine the granularity 
of a computation can be. For example, in the case of 
multiplying a dense matrix with a vector, there can be no 
more than (n2) concurrent tasks.  


• Concurrent tasks may also have to exchange data with 
other tasks. This results in communication overhead. 
The tradeoff between the granularity of a decomposition 
and associated overheads often determines 
performance bounds.  


 







Processes and Mapping  


•  In general, the number of tasks in a decomposition exceeds the 
number of processing elements available.  


•  For this reason, a parallel algorithm must also provide a mapping of 
tasks to processes.  


  







Processes and Mapping  


• Appropriate mapping of tasks to processes is critical to 
the parallel performance of an algorithm.  


• Mappings are determined by both the task dependency 
and task interaction graphs.  


• Task dependency graphs can be used to ensure that 
work is equally spread across all processes at any point 
(minimum idling and optimal load balance).  


• Task interaction graphs can be used to make sure that 
processes need minimum interaction with other 
processes (minimum communication).  


 







Processes and Mapping  


An appropriate mapping must minimize parallel execution time by:  


 


•  Mapping independent tasks to different processes.  


•  Assigning tasks on critical path to processes as soon as they 
become available.  


•  Minimizing interaction between processes by mapping tasks with 
dense interactions to the same process.  


    Note: These criteria often conflict with each other. For example, a 
decomposition into one task (or no decomposition at all) minimizes 
interaction but does not result in a speedup at all!   







Decomposition Techniques  


 So how does one decompose a task into various subtasks?  


 While there is no single recipe that works for all problems, we 
present a set of commonly used techniques that apply to broad 
classes of problems. These include:  


 


•  recursive decomposition  


•  data decomposition  


•  exploratory decomposition 


•  hybrid decomposition  


 


 







Data Decomposition: Example  


 Consider the problem of multiplying two n x n matrices A and B to yield 
matrix C. The output matrix C can be partitioned into four tasks as follows:  


Task 1: 	




Task 2:	




Task 3:	




Task 4: 	









Data Decomposition: Example  


 A partitioning of output data does not result in a unique decomposition 
into tasks. For example, for the same problem as in previous slide, with 
identical output data distribution, we can derive the following two 
(different) decompositions:  


Decomposition I Decomposition II 


Task 1:  C1,1 = A1,1 B1,1   


Task 2:  C1,1 = C1,1 + A1,2 B2,1  


Task 3:  C1,2 = A1,1 B1,2  


Task 4:  C1,2 = C1,2 + A1,2 B2,2  


Task 5:  C2,1 = A2,1 B1,1  


Task 6:  C2,1 = C2,1 + A2,2 B2,1  


Task 7:  C2,2 = A2,1 B1,2  


Task 8:  C2,2 = C2,2 + A2,2 B2,2  


Task 1:  C1,1 = A1,1 B1,1    


Task 2:  C1,1 = C1,1 + A1,2 B2,1  


Task 3:  C1,2 = A1,2 B2,2  


Task 4:  C1,2 = C1,2 + A1,1 B1,2  


Task 5:  C2,1 = A2,2 B2,1  


Task 6:  C2,1 = C2,1 + A2,1 B1,1  


Task 7:  C2,2 = A2,1 B1,2  


Task 8:  C2,2 = C2,2 + A2,2 B2,2  







Intermediate Data Partitioning  


• Computation can often be viewed as a sequence of 
transformation from the input to the output data.  


•  In these cases, it is often beneficial to use one of the 
intermediate stages as a basis for decomposition.  







Intermediate Data Partitioning: Example  


 Let us revisit the example of dense matrix multiplication. We first show how we 
can visualize this computation in terms of intermediate matrices  D.  







Intermediate Data Partitioning 


 A decomposition of intermediate data structure   leads to the following 
decomposition into 8 + 4 tasks: 


         Stage I 


Stage II	




Task 01:  D1,1,1= A1,1 B1,1 Task 02:  D2,1,1= A1,2 B2,1 


Task 03:  D1,1,2= A1,1 B1,2 Task 04:  D2,1,2= A1,2 B2,2 
Task 05:  D1,2,1= A2,1 B1,1 Task 06:  D2,2,1= A2,2 B2,1 
Task 07:  D1,2,2= A2,1 B1,2 Task 08:  D2,2,2= A2,2 B2,2 
Task 09:  C1,1 = D1,1,1 + D2,1,1 Task 10:  C1,2 = D1,1,2 + D2,1,2 


Task 11:  C2,1 = D1,2,1 + D2,2,1 Task 12:  C2,,2 = D1,2,2 + D2,2,2 







Exploratory Decomposition  


•  In many cases, the decomposition of the problem goes 
hand-in-hand with its execution.  


• These problems typically involve the exploration 
(search) of a state space of solutions.  


• Problems in this class include a variety of discrete 
optimization problems (0/1 integer programmin, etc.), 
theorem proving, game playing, etc.  







Speculative Decomposition  


•  In some applications, dependencies between tasks are 
not known a-priori.  


• For such applications, it is impossible to identify 
independent tasks.  


• There are generally two approaches to dealing with 
such applications: conservative approaches, which 
identify independent tasks only when they are 
guaranteed to not have dependencies, and, optimistic 
approaches, which schedule tasks even when they may 
potentially be erroneous.  


• Conservative approaches may yield little concurrency 
and optimistic approaches may require roll-back 
mechanism in the case of an error.  







Characteristics of Tasks  


 Once a problem has been decomposed into independent 
tasks, the characteristics of these tasks critically impact 
choice and performance of parallel algorithms. Relevant task 
characteristics include:  


•  Task generation.  


•  Task sizes.  


•  Size of data associated with tasks.  







Task Generation  


• Static task generation: Concurrent tasks can be 
identified a-priori ( matrix operations). 


• Dynamic task generation (generated during 
computation) 







Task Sizes  


•  Task sizes may be uniform (i.e., all tasks are the same size) 
or non-uniform.  


•  Non-uniform task sizes may be such that they can be 
determined (or estimated) a-priori or not.  


•  Examples in this class include discrete optimization problems, 
in which it is difficult to estimate the effective size of a state 
space.  







Size of Data Associated with Tasks  


• The size of data associated with a task may be small or 
large when viewed in the context of the size of the task.  


• A small context of a task implies that an algorithm can 
easily communicate this task to other processes 
dynamically.  


• A large context ties the task to a process, or alternately, 
an algorithm may attempt to reconstruct the context at 
another processes as opposed to communicating the 
context of the task (e.g., 0/1 integer programming).  







Characteristics of Task Interactions  


• Tasks may communicate with each other in various 
ways. The associated dichotomy is:  


• Static interactions: The tasks and their interactions are 
known a-priori. These are relatively simpler to code into 
programs.  


• Dynamic interactions: The timing or interacting tasks 
cannot be determined a-priori. These interactions are 
harder to code, especially, as we shall see, using 
message passing APIs. 







Characteristics of Task Interactions  


• Regular interactions: There is a definite pattern (in the 
graph sense) to the interactions. These patterns can be 
exploited for efficient implementation.  


•  Irregular interactions: Interactions lack well-defined 
topologies.  







Characteristics of Task Interactions  


•  Interactions may be read-only or read-write.  


•  In read-only interactions, tasks just read data items 
associated with other tasks.  


•  In read-write interactions tasks read, as well as modify 
data items associated with other tasks.  


•  In general, read-write interactions are harder to code, 
since they require additional synchronization primitives.  







Characteristics of Task Interactions  


•  Interactions may be one-way or two-way.  


• A one-way interaction can be initiated and accomplished 
by one of the two interacting tasks.  


• A two-way interaction requires participation from both 
tasks involved in an interaction.  


• One way interactions are somewhat harder to code in 
message passing APIs.  







Mapping Techniques  


• Once a problem has been decomposed into concurrent 
tasks, these must be mapped to processes (that can be 
executed on a parallel platform).  


• Mappings must minimize overheads.  


• Primary overheads are communication and idling.  


• Minimizing these overheads often represents 
contradicting objectives.  


• Assigning all work to one processor trivially minimizes 
communication at the expense of significant idling.  







Mapping Techniques for Minimum Idling 


 Mapping techniques can be static or dynamic.  


 


•  Static Mapping: Tasks are mapped to processes a-priori. For this to 
work, we must have a good estimate of the size of each task. Even 
in these cases, the problem may be NP complete.  


•  Dynamic Mapping: Tasks are mapped to processes at runtime. This 
may be because the tasks are generated at runtime, or that their 
sizes are not known.  


  


 Other factors that determine the choice of techniques include the size of data 
associated with a task and the nature of underlying domain. 







Schemes for Static Mapping  


• Mappings based on data partitioning.  


• Mappings based on task graph partitioning – functional 
decomposition 


•  Hybrid mappings.  







Block Array Distribution Schemes  


 Block distribution schemes can be generalized to 
higher dimensions as well.  







Cyclic and Block Cyclic Distributions  


•  If the amount of computation associated with data items 
varies, a block decomposition may lead to significant load 
imbalances.  


•  A simple example of this is in LU decomposition (or Gaussian 
Elimination) of dense matrices.  







Block-Cyclic Distribution  


•  A cyclic distribution is a special case in which block size is one. 	


•  A block distribution is a special case in which block size is n/p  , where n is 


the dimension of the matrix and p is the number of processes. 	









Mappings Based on Task Partitioning  


• Partitioning a given task-dependency graph across 
processes.  


• Determining an optimal mapping for a general task-
dependency graph is an NP-complete problem.  


• Excellent heuristics exist for structured graphs.  







Hierarchical Mappings  


• Sometimes a single mapping technique is inadequate.  


• For example, the task mapping of the binary tree 
(quicksort) cannot use a large number of processors.  


• For this reason, task mapping can be used at the top 
level and data partitioning within each level.  







Minimizing Interaction Overheads  


• Maximize data locality: Where possible, reuse 
intermediate data. Restructure computation so that data 
can be reused in smaller time windows.  


• Minimize volume of data exchange: There is a cost 
associated with each word that is communicated. For 
this reason, we must minimize the volume of data 
communicated.  


• Minimize frequency of interactions: There is a startup 
cost associated with each interaction. Therefore, try to 
merge multiple interactions to one, where possible.  


• Minimize contention and hot-spots: Use decentralized 
techniques, replicate data where necessary.  







Minimizing Interaction Overheads (continued)  


• Overlapping computations with interactions: Use non-
blocking communications, multithreading, and 
prefetching to hide latencies.  


• Replicating data or computations.  


• Using group communications instead of point-to-point 
primitives.  


• Overlap interactions with other interactions.  







Parallel Algorithm Models  


 An algorithm model is a way of structuring a parallel 
algorithm by selecting a decomposition and mapping 
technique and applying the appropriate strategy to 
minimize interactions.  


• Data Parallel Model (Data Decomposition): Tasks are 
statically (or semi-statically) mapped to processes and 
each task performs similar operations on different data.  


• Task Graph Model (Functional Decomposition): Starting 
from a task dependency graph, the interrelationships 
among the tasks are utilized to promote locality or to 
reduce interaction costs.  







Parallel Algorithm Models (cont.)  


• SPMD – Single Program Multiple Data model 


• MPMD – Multiple Programs Multiple Data model 


• Master-Slave Model: One or more processes generate 
work and allocate it to worker processes. This allocation 
may be static or dynamic.  


• Pipeline / Producer-Consumer Model: A stream of data 
is passed through a succession of processes, each of 
which perform some task on it.  


• Hybrid Models: A hybrid model may be composed either 
of multiple models applied hierarchically or multiple 
models applied sequentially to different phases of a 
parallel algorithm.  







Parallel Algorithms Design 


• Start from an existing  sequential algorithm and design 
new parallel one. 


• Start from existing parallel algorithms and improve it. 


• Design  completely new parallel algorithm. 







Parallel Algorithms Design  -  Summary 


• Choose the  initial decomposition technique depending 
on the given problem. 


• Replicate the data to minimize the communication if 
necessary 


• Define initial task sizes. 


• Map initial parallel algorithm onto parallel architecture. 


• Calibrate the algorithm by optimizing the task size and 
minimizing the communication. 


• Arrive iteratively into the refined parallel algorithm. 


Remember, the parallel algorithm has to be much faster 
than the sequential one! 
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Eduard Ayguadé and Rosa M. Badia


Barcelona. November 2012
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Motivation API and example of use Installation
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Tareador environment
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Motivation API and example of use Installation
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Motivation


API and example of use
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Motivation API and example of use Installation


Parallelization strategy


I Task decomposition
I From a sequential specification of the program ...
I ... find a decomposition of the problem in tasks (i.e. identify


pieces of work that can execute concurrently) ...
I ... ensuring that the same result is produced (i.e. identify


dependencies that impose ordering and data sharing
constraints).


I These tasks and constraints can be later mapped to the
elements offered by parallel programming languages
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Motivation API and example of use Installation


Guiding the task decomposition process


Tareador: environment to support the task decomposition process:


I API to annotate sequential program with potential tasks


I Binary instrumentation using a new Valgrind module


I Visualization of task graph (granularities and dependences)


I Simulation with Dimemas and visualization with Paraver


Sequen&al	
  
code	
  with	
  
Tareador	
  


annota&ons	
  
Na&ve	
  compiler	
   Instrumented	
  


execu&on	
  


Execution trace 


Graph	
  maker	
  
script	
  


Dimemas	
  
simulator	
  


Paraver visualizer 


Task graph visualizer 
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Motivation API and example of use Installation


Computation task graph abstraction


I Directed Acyclic Graph


I Node = dynamic instance of an annotated
task (tracking of task entry/exit)


I Edge = dependence between tasks
(tracking of dynamic allocations and
memory accesses)
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Motivation API and example of use Installation


Computation task graph abstraction


I T1 =
∑nodes


i=1 (work nodei)


I T∞ =
∑


i∈criticalpath(work nodei),
assuming sufficient resources


I Parallelism = T1/T∞


Eduard Ayguadé and Rosa M. Badia


Exploring task decomposition strategies with Tareador 7 / 25







Motivation API and example of use Installation


Computation task graph abstraction


I Tp = execution time on P processors
(depends on the schedule of the graph
nodes on the processors)


I Speedup on P processors: Sp = T1/Tp


I Dimemas reconstructs a temporal
parallel execution to determine Tp:


I parametrizable architecture
I what if optimizing a certain task
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Motivation API and example of use Installation


Exploration of potential task decompositions


void update( ... ) { 
   HPL_dtrsm( ... ); 
   HPL_dgemm(... ); 
} 
 
main() { 
 
... 
   for( j = 0; j < N; j += BS ) 
   { 
      panel_init( ... ); 
      if (cond0) 
          fact( ... ); 
      init_for_pivoting( ... ); 
      for(i = k; i < P; i+= BS) { 
 
         if(cond1) 
             HPL_dlaswp01N( ... ); 
         HPL_spreadN( ... ); 
         if(cond2) 
             HPL_dlaswp06N( ... ); 
         if(cond3) 
             HPL_dlacpy( ... ); 
         HPL_rollN( ... ); 
         HPL_dlaswp00N( ... ); 
         update( ... ); 
      } 
   } 
... 
} 


T
0	




T
1	




T
2	




T
3	




T
4	




T
5	




T
6	




T
7	




T
8	




T
9	




taskification	




The	
  parallelism	
  is	
  released	
  in	
  transi/on	
  T3	
  -­‐>	
  T4	
  
	
  when	
  func/on	
  update	
  is	
  separated	
  from	
  	
  
	
  the	
  rest	
  of	
  the	
  inner	
  loop	
  


*HP	
  Linpack:	
  
	
  4	
  MPI	
  processes;	
  
	
  Problem	
  size:	
  8192;	
  
	
  Block	
  size:	
  256,128,	
  64,	
  32.	
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Motivation API and example of use Installation
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Motivation API and example of use Installation


Tareador API


I Specification of tareador region
tareador_ON();


...


tareador_OFF();


I Specification of task boundaries
tareador_start_task("name of task");


/* Code region / task */


tareador_end_task();


Recursive tasks are possible (e.g. divide and conquer approaches).


I Filtering objects
tareador_disable_object(address of object);


/* Code region */


tareador_enable_object(address of object);
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Motivation API and example of use Installation


Example: dot product


Instrumented source code for iterative dot product:


void dot_product (long N,


double A[N], double B[N], double *acc){
double prod;


*acc=0.0;


for (int i=0; i<N; i++) {
tareador start task(”inner product”);
prod = A[i]*B[i];


*acc+= prod;


tareador end task();
}


}


int main() {
tareador ON ();


tareador start task(”init A”);
for (int i=0; i< N; i++) A[i]=i;


tareador end task();


tareador start task(”init B”);
for (int i=0; i< N; i++) B[i]=2*i;


tareador end task();


dot_product (N, A, B, &result);


tareador OFF ();


}
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Motivation API and example of use Installation


Dot product: task graph, N=16


init_A
ID=1
inst=236
nesting=1


inner_product
ID=3
inst=54
nesting=1


inner_product
ID=4
inst=54
nesting=1


inner_product
ID=5
inst=54
nesting=1


inner_product
ID=6
inst=54
nesting=1


inner_product
ID=7
inst=54
nesting=1


inner_product
ID=8
inst=54
nesting=1


inner_product
ID=9
inst=54
nesting=1


inner_product
ID=10
inst=54
nesting=1


inner_product
ID=11
inst=54
nesting=1


inner_product
ID=12
inst=54
nesting=1


inner_product
ID=13
inst=54
nesting=1


inner_product
ID=14
inst=54
nesting=1


inner_product
ID=15
inst=54
nesting=1


inner_product
ID=16
inst=54
nesting=1


inner_product
ID=17
inst=54
nesting=1


inner_product
ID=18
inst=54
nesting=1


init_B
ID=2
inst=268
nesting=1
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Motivation API and example of use Installation


Dot product: Dimemas simulation, N=16, 4 CPU


I CPU view load configuration


I Maximum concurrency view configuration
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Motivation API and example of use Installation


Example: dot product (cont.)


Instrumented source code (filtering object acc) for iterative dot
product:


void dot_product (long N,


double A[N], double B[N], double *acc){
double prod;


*acc=0.0;


for (int i=0; i<N; i++) {
tareador˙start˙task(”inner product”);
prod = A[i]*B[i];


tareador disable object(acc);
*acc+= prod;


tareador enable object(acc);
tareador end task();


}
}


int main() {
tareador ON ();


tareador start task(”init A”);
for (int i=0; i< N; i++) A[i]=i;


tareador end task();


tareador start task(”init B”);
for (int i=0; i< N; i++) B[i]=2*i;


tareador end task();


dot_product (N, A, B, &result);


tareador OFF ();
}
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Motivation API and example of use Installation


Dot product: task graph filtering acc, N=16


init_A
ID=1


inst=236
nesting=1


inner_product
ID=3


inst=1663
nesting=1


inner_product
ID=4


inst=277
nesting=1


inner_product
ID=5


inst=277
nesting=1


inner_product
ID=6


inst=277
nesting=1


inner_product
ID=7


inst=277
nesting=1


inner_product
ID=8


inst=277
nesting=1


inner_product
ID=9


inst=277
nesting=1


inner_product
ID=10
inst=277
nesting=1


inner_product
ID=11
inst=277
nesting=1


inner_product
ID=12
inst=277
nesting=1


inner_product
ID=13
inst=277
nesting=1


inner_product
ID=14
inst=277
nesting=1


inner_product
ID=15
inst=277
nesting=1


inner_product
ID=16
inst=277
nesting=1


inner_product
ID=17
inst=277
nesting=1


inner_product
ID=18
inst=277
nesting=1


init_B
ID=2


inst=268
nesting=1
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Motivation API and example of use Installation


Dot product: Dimemas simulation filtering acc, N=16


I CPU view load configuration


I Maximum concurrency view configuration
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Motivation API and example of use Installation


Dot product: Dimemas simulation comparison, N=16


I Comparison at same time scale
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Motivation API and example of use Installation


Outline


Motivation
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Motivation API and example of use Installation


Installation


I Already installed in Minotauro, paths for library and include
file set in environment.bash


I Installation of tarball for Linux, which can be downloaded
from http://bscgrid06.bsc.es/~tareador/download


I Also available as a Web portal with execution on the Grid:
http://bscgrid06.bsc.es/~tareador


I Useful for interactive hands-on and demo sessions
I Simple task graph and simulation visualizers
I Timeouts in each step of the process
I Some limitations (single file, no input files, ...)
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Part II


Hands-on
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Solving the heat equation


iter = 0;


while(1) {


switch( param.algorithm ) {


case 0: // JACOBI


residual = relax_jacobi(param.u, param.uhelp, np, np);


// Copy uhelp into u


for (i=0; i<np; i++)


for (j=0; j<np; j++)


param.u[ i*np+j ] = param.uhelp[ i*np+j ];


break;


case 1: // GAUSS


residual = relax_gauss(param.u, np, np);


break;


case 2: // RED-BLACK


residual = relax_redblack(param.u, np, np);


break;


}


iter++;


// solution good enough ?


if (residual < 0.00005) break;


// max. iteration reached ? (no limit with maxiter=0)


if (param.maxiter>0 && iter>=param.maxiter) break;


}


sizex 


sizey 


by 


bx 
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Solving the heat equation (Jacobi solver)


double relax_jacobi (double *u, double *utmp,


unsigned sizex, unsigned sizey) {


double diff, sum=0.0;


int nbx, bx, nby, by;


nbx = NB; bx = sizex/nbx;


nby = NB; by = sizey/nby;


for (int ii=0; ii<nbx; ii++)


for (int jj=0; jj<nby; jj++)


for (int i=1+ii*bx; i<=min((ii+1)*bx, sizex-2); i++)


for (int j=1+jj*by; j<=min((jj+1)*by, sizey-2); j++) {


utmp[i*sizey+j]= 0.25 * (u[ i*sizey + (j-1) ]+


u[ i*sizey + (j+1) ]+


u[ (i-1)*sizey + j ]+


u[ (i+1)*sizey + j ]);


diff = utmp[i*sizey+j] - u[i*sizey + j];


sum += diff * diff;


}


return sum;


}


sizex 


sizey 


by 


bx 
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Solving the heat equation (hands-on outline)


1. Try the initial task definition (Jacobi solver, one task per
computation of block)


2. Which dependence is causing the serialization of all tasks?


3. Filter the object that causes the dependence
(tareador disable object and tareador enable object)


4. Dimemas simulation with different number of processors


5. What else could be parallelized (or sequentially optimized)?


6. Repeat process with Red–Black solver


7. Repeat process with Gauss-Seidel solver
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Performance analysis tools objective 


 


 


Help generate hypotheses 
 


 


Help validate hypotheses 
qualitatively 


quantitetively 
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Our tools 


Since 1991 


Based on traces 


Open Source 


– http://www.bsc.es/paraver 


 


Core tools 


– Paraver (paramedir) – offline trace analysis 


– Dimemas – message passing simulator 


– Extrae – instrumentation 


 


Focus 


– Detail, flexibility and intelligence 



http://www.bsc.es/paraver

http://www.bsc.es/paraver
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Why traces? 


Detail and variability are important 


– Along time, across processors 


 


Highly non-linear systems 


– Small effects may have huge impact 


 


Useful to develop/test analysis techniques 
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… at the end of the session 


 


 


One image is worth 1000 words! 


– Learning to read it pays off! 


 


 


Do not speculate about your code performance, look at it! 
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Outline 


Extrae 


Paraver 


– General description 


– Examples 


Research topics 


– Structure detection 


– On-line analysis 


– Folding 


Hands-on session 







Instrumentation Merge 
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Trace Generation Workflow 


PRV 
MPIT 


Application 


Process 


Extrae 


Application 


Process 


Extrae 


Application 


Process 


Extrae lib 
MPIT 


MPIT 


Paraver 


Dimemas 


Folding 


… 


Analysis 
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Extrae 


Parallel programming model runtime 


– MPI, OpenMP, pthreads, *Ss, CUDA, MIC… 


Counters 


– CPU counters 


• Using PAPI and PMAPI interfaces 


– Network counters 


– OS counters 


Link to source code 


– Callstack at MPI 


– OpenMP outlined routines and their containers 


– User functions selected 


Periodic samples 


User events 
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How does Extrae work? 


Dynamic instrumentation 


– Based on DynInst (developed by U.Wisconsin/U.Maryland) 


• Instrumentation in memory 


• Binary rewriting 


LD_PRELOAD 


– Specific libraries for each combination of runtimes 


• MPI 


• OpenMP 


• OpenMP+MPI 


• … 


Alternatives 


– OmpSs 


– Statically link (i.e., PMPI) 
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How to use Extrae? 


Adapt job submission script 


Adapt .xml configuration file 


– Bunch of examples distributed in the package 


• Look at $EXTRAE_HOME/share/example 


Run it! 
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Extrae with DynInst 


#!/bin/bash 


… 


# @ total_tasks = 4 


# @ cpus_per_task = 1 


# @ tasks_per_node = 4 


… 


 


srun ./my_MPI_binary 


#!/bin/bash 


… 


# @ total_tasks = 4 


# @ cpus_per_task = 1 


# @ tasks_per_node = 4 


… 


 


srun ./trace.sh ./my_MPI_binary 


appl.job 


#!/bin/sh 


 


export EXTRAE_HOME=… 


export EXTRAE_CONFIG_FILE=extrae.xml 


source ${EXTRAE_HOME}/etc/extrae.sh 


 


# Run the desired program 


${EXTRAE_HOME}/bin/extrae –v $* 


trace.sh 
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Extrae with LD_PRELOAD 


#!/bin/bash 


… 


# @ total_tasks = 4 


# @ cpus_per_task = 1 


# @ tasks_per_node = 4 


… 


 


srun ./trace.sh ./my_MPI_binary 


appl.job 


#!/bin/sh 


 


export EXTRAE_HOME=… 


export EXTRAE_CONFIG_FILE=extrae.xml 


export LD_PRELOAD=${EXTRAE_HOME}/lib/libmpitrace.so 


 


# Run the desired program 


$* 


trace.sh 
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LD_PRELOAD library selection 


Choose depending on the application type 


Library Serial MPI OpenMP pthread CUDA 


libseqtrace  


libmpitrace[f]1  


libomptrace  


libpttrace  


libcudatrace  


libompitrace[f] 1   


libptmpitrace[f] 1   


libcudampitrace[f] 1   


1 for Fortran codes 
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Multispectral imaging 


Different looks at one reality 


– Different light sources using filters 


Highlight different aspects 


Zoom in & out 







 


 


 


 


Our goal is flexibility 


– No semantics 


– Programmable 


 


Configuration files 


– Distributed with Paraver 


– You can write your own 
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Paraver 


PRV 


Raw performance data 


MPI calls, OpenMP regions, user functions, 


p2p & collective communications, 


performance counters, samples, … 


Timelines 


2D / 3D tables 


(statistics) 
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Timelines: Description 


 


Time 


Objects 


    Process dimension 
        - Thread (default) 


        - Process 


        - Application 


        - Workload 


    Resource dimension  
        - CPU 


        - Node 


        - System 
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Timelines: Semantics 


Each window displays one view 


– Piecewise constant function of time 


– One such function of time per object: 


• Thread, process, application, workload, CPU, node 


 


Types of functions 


– Categorical 


• State, user function, which MPI call 


– Logical 


• In specific user function, In MPI call, In long MPI call 


– Numerical 


• IPC, L2 miss ratio, Duration of MPI call, duration of computation burst 


 


 
1


,,)(




iii


ttiStS


  NS
i


 n0, 


 1 ,0 
i


S


RS
i


 







19 


Timelines: Display 


Representation 


– Function of time 


 


– Color encoding 


 


– Gradient color 


• From light green to dark blue 


• Limits in yellow and orange 


 


– Not null gradient 


• Black (or background) for zero value 


• From light green to dark blue 


• Limits in yellow and orange 


Min 


Max 


Min 


Max 


0 
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Timelines: Deriving 


Basic metrics 


 


 


 


Derived metrics 


 


 


 


 


Models 


L2miss latency


=
cycles− instr / idealIPC


L2misses


useful
cycles


instr
IPCuseful *


#


#
_ 


bytes


durationcallMPI
CostcallMPI


#


__
__ 


MPI call Instructions 


Min 


Max 


Min 


Max 


0 


Min 


Max 


0 


Min 


Max 


0 
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Tables: profiles, histograms and correlations 


Huge number of statistics computed from any timeline 


Useful duration IPC 


L2 miss ratio Instructions 


MPI call profile 
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Tables: How to read profiles 


MPI call,user function,… 


 


 


T
h
re


a
d
 


  
Value/color is a statistic computed for the given thread 


when control window had the value corresponding to the column 


 


Relevant statistics: 


time, %time, avg. burst time, average of data window 


One column per categorical value of Control window 
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Tables: How to read histograms 


Duration,instructions,BW,IPC, ... 


 


 


T
h
re


a
d
 


  
Value/color is a statistic computed for the given thread 


when control window had the value corresponding to the column 


 


Relevant statistics: 


time, %time, avg. burst time, average of data window 


Columns correspond to bins of values of a numeric Control window 
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Tables: back to timelines 


Where in the timeline do the values in certain table columns 


appear? 


– i.e. which is the time distribution of a given routine? 


– i.e. when does a routine occur in the timeline? 
Click button an 


select column(s) 
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Comparative analyses 


Possible to load several traces 


– And thus perform execution comparison 


 


Copy and paste between windows 


– right click menu 


– from one window to another: time, duration, size, objects displayed,… 


– time between windows and tables 


• analysis computed only for the selected time interval 


 


Synchronize windows 
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Distribution of cfg directories 


CFG are programmed Paraver windows 


– General 


• including basic views (timelines) and analysis (2/3D profiles), including 


views of the user functions and call-stack 


– Counters_PAPI 


• Hardware counter derived metrics. Grouped in directories for 


– Program: related to algorithmic/compilation (i.e. instructions,FP ops,…) 


– Architecture: related to execution on specific architectures (i.e. cache 


misses,…) 


– Performance: metrics reporting rates per time (i.e. MFLops, MIPS, IPC,…) 


– MPI 


• Grouped in directories displaying views and analysis. Further separated 


into point to point and collectives. 


– OpenMP 


• Grouped in directories displaying views and analysis 
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Outline 


Extrae 


Paraver 


– General description 


– Examples 


Research topics 


– Structure detection 


– On-line analysis 


– Folding 


Hands-on session 
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Example 1: Analysing ERGO (OpenMP) 


ERGO – 8 OpenMP threads 


Parallel functions view 


– Structure? Very different phases 


– Some phases delimited by sequential code (light blue) 
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Example 1: Analysing ERGO (OpenMP) 


Loops balanced between threads 


Less than 30% time is paralellised (limited scalability) 
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Example 1: Analysing ERGO (OpenMP) 


ERGO scalability 


8 threads 


16 threads 


24 threads 
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Example 2: FrontFlowRed 


256 vs 512 tasks 


– Imbalance and MPI time increases 


– Sequence of MPI_Allreduce 


– Poor IPC, high cache misses 


Metric 256 512 


Parallel efficiency 27% 19% 


Load balance 56% 48% 


% MPI_Allreduce 45% 62% 
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Example 2: FrontFlowRed 


Modifications in the source code 


– Improved load balance – weight nodes based on their connectivity 


– Reduction of alltoall communications 


– Reduce cache misses – reordering node number 


 


½ hour meeting for the analysis + few days modifying code  


 25% improvement 
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Example 2: FrontFlowRed 


256 tasks – Load balance 
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Example 2: FrontFlowRed 


256 tasks – MPI time 
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Example 2: FrontFlowRed 


256 tasks – memory access 
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Outline 


Extrae 


Paraver 


– General description 


– Examples 


Research topics 


– Structure detection 


– On-line analysis 


– Folding 
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Performance @ serial computation bursts 


Burst = continuous computation region 


– i.e., between exit of an MPI call and entry to the next 


 


Scatter-plot representation of bursts 


– Collapse time dimension 


– N dimensional space of HWC metric 


• Instructions: computational complexity, computational load imbalance,… 


• IPC: absolute performance and performance imbalance 


 


Structure 


– Clouds, clusters: Burst of similar characteristics 


– How these similarities spread along the timeline? 
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Clustering module – detecting structure 


Scatterplot of clustered metrics Clusters distribution over time 
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Clustering module – detecting structure 


Most relevant computing  


regions (colored in green  


and yellow) obtain poor IPC 


Huge instructions variability 


in red and pink regions 
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Gromacs example 


Gromacs FFTs balance 


Instructions imbalance 


IPC imbalance 
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Outline 


Extrae 


Paraver 


– General description 


– Examples 


Research topics 


– Structure detection 


– On-line analysis 


– Folding 


Hands-on session 
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On-line analysis 


Traces of “100 Mbytes” 


– Trigger clustering analysis periodically 


• Sequence of structure snapshots 


– Compare subsequent clusterings 


• See changes in application behavior 


– Find a representative region 


• Most application are highly iterative 
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Modules integration 


Data acquisition 


– Extrae (BSC) 


• PMPI wrappers 


• Extrae communication thread 


Data transmission 


– MRNet (U. Wisconsin) 


• Scalable master/worker 


• Tree topology 


Data analysis 


– Clustering analysis (BSC) 


• Find structure 


T0 


Clustering 


Analysis 


MRNet 


Front-


end 


T1 Tn 


Application tasks 
Extrae attaches 


Reduction 


Network 


… … … 
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On-line analysis: MILC 


 


 


 


 


 


 


 


 


 


 


 


 


60 Mb, 6 iterations 
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Folding 


Get detailed metrics with few samples 


– Detailed sampling is costly 


– Combines instrumentation and sampling 


 


Takes advantage of long iterative code regions 


 


Iteration #1 Iteration #2 Iteration #3 


Synth Iteration 


Initialization Finalization 
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Folding: hardware counters 


Instructions evolution for copy_faces of NAS MPI BT.B 


Red crosses represent the 


folded samples and show 


the completed instructions 


from the start of the routine 


Blue line is the derivative of 


the curve fitting over time 


(counter rate) 
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Folding + models 


Combine multiple performance counters in a plot 
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Folding: reference to source code 


Call-site sampling information is folded 


– Correlation between hwc and call-sites 


– GVIM add-on to show performance within source code 


• Timeless but useful to point performance issues 


Folded  source code line 


Folded instructions 
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Example: PEPC 


96 MIPS 


 htable%node = 0 


 htable%key = 0 


 htable%link = -1 


 htable%leaves = 0 


 htable%childcode = 0 


do i = 1, n 


 htable(i)%node = 0 


 htable(i)%key = 0 


 htable(i)%link = -1 


 htable(i)%leaves = 0 


 htable(i)%childcode = 0 


End do 


Performance metrics 


16 MIPS 


2.3 L2 misses/s 


0.1 TLB misses/s 


403 MIPS 
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Example: PEPC (optimized)  


Changes 


-70% time 


-18% instructions 


-63% L2 misses 


-78% TLB misses 


254 MIPS 


(+163%) 


Changes 


-30% time 


-1% instructions 


-10% L2 misses 


-32% TLB misses 


544 MIPS (+34%) 
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www.bsc.es 


Thank you! 


For further information please contact us at 


tools@bsc.es 
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Introduction to Analysis with Paraver


MPI


Material


•  This directory contains an example and guidelines to get started on the use of Paraver to analyze a 
trace. You can find:
◦  A  trace  file  Iberia-128-CA.chop1.1it.shifted.prv.gz  for  a  128 processor  run  of  the  WRF 


application.  The  trace  was  obtained  on  MareNostrum  with  MPItrace,  using  the 
LD_PRELOAD mechanism to intercept  entries and exits to MPI. The traces  thus contain 
events on entry and exit to the MPI calls and hardware counter (cache misses, instructions and 
cycles) events at these points.


◦  The  corresponding  .pcf  file  with  the  symbolic  information  for  the  numerically  encoded 
records in the trace.


◦ A directory (cfgs) with several configuration files that will be used during the session.


Timelines: Navigation and Basic concepts


Let us go through some basic navigation and analysis functionalities.


•  Launch paraver  (wxparaver)


•  Select “File → Preferences”, and on the “Global” tab, set the default trace and configuration file 
locations to the <current working directory>, and <current working directory>/cfgs, respectively. 
For example, set the “Traces” directory to “/home/username/intro2paraver_MPI”, and the “CFGS” 
directory to “/home/username/intro2paraver_MPI/cfgs”.


•  Load trace:  From the main menu, select “File → Load Trace...”, and select the file Iberia-128-
CA.chop1.1it.shifted.prv.gz.


◦ After the file is loaded,  from the main menu, select “File → Load Configuration...”, and 
select  mpi_call.cfg.  A display window will appear with the timeline of which MPI call is 
being executed at each point in time by each process. The horizontal axis represents time, 
from the start time of the application at the left of the window to the end time at the right. For 
every thread, the colors represent the MPI call  or black when doing user level computation 
outside of MPI.


◦  Info  Panel:  Right  Button (anywhere  inside  the  window) →  Info  Panel,  then select  the 
“Colors” tab: displays a table indicating the meaning for each color in this specific window.



Iberia-128-CA.chop1.1it.shifted.prv.gz

Iberia-128-CA.chop1.1it.shifted.prv.gz

cfgs/mpi_call.cfg





◦  Zoom:  Click with the Left Button of the mouse to select the starting time of the zoomed 
view, drag the mouse over the area of interest, and release the mouse to select the end time of  
the zoomed view.


◦  Undo Zoom and Redo Zoom commands are available on the Right Button menu. You can 
do and undo several levels of zooming.


◦  The  Control-Zoom option  will  let  you  select  a  subset  of  threads.  This  is  useful  when 
analyzing runs with many processes and you want to concentrate on a few of them. Hold 
down the  “Control”  or  “CTRL”  key  on  the  keyboard,  and  using  the  mouse,  identify  a 
rectangular area by clicking on top left corner of the desired area with the left mouse button 
and dragging and releasing the button on the bottom right corner.


◦  Flags:  Right-click  on  the  window,  and  select  the  “View  →  Event  Flags”  checkbox. 
Alternatively,  you can toggle the flag button on the “View” tab on the  Info Panel.  Flags 
appear at the entry and exit points to the MPI calls. Depending on the scale, displaying flags 
may help differentiate whether there is one or many MPI calls at a given zoom level.


◦  To measure time between any two points in the trace: Use the Shift-Zoom combination to 
activate the timing. The time and the interval between the two selected points of the trace is  
displayed in the “Timing” tab of the Info Panel.


•  Load  configuration  file  useful_IPC.cfg.   From  the  main  menu,  select  “File  →  Load 
Configuration...”, and select the configuration file specified.


◦  This configuration file shows a timeline with the instructions per cycle (IPC) achieved by in  
each interval of useful computation.  Right-click on the window, select “Info Panel”, and 
select the “Color” tab to see the actual coloring scheme and scale for this window. The IPC 
function of time for each process is represented as a gradient between light green representing 
a low IPC value and dark blue representing a high IPC value. This view shows  in black in the 
regions where processes are in MPI in order to let us focus on the actual useful computation  
parts. 


◦  Display as a function of time: Use the Control-Zoom to select a few processes for the whole 
duration of the trace. Click in the “View” tab in the Info Panel of the window, and un-select 
the “Function Line With Color” checkbox. You will see a display of the IPC for the selected 
processes as a function of time. Both the color and function of time view present the same 
information. The color scheme is inherently more scalable.


◦  Textual Display: Click with the Left Button on any point in the window. It will list in textual 
form the actual value of IPC at the point selected (an vicinity if time scale too coarse).  The 
text display will be in the “What/Where” tab of the Info Panel.


◦  Y scale: you can change the vertical scale for the function of time representation as well as 
for the color encoding. To manually control the scale, use the “Semantic Maximum” and 
“Semantic Minimum” fields in the Main Window. Just keep in mind that values outside the 
specified  range  will  be  truncated  in  the  function  of  time  display  and  will  be  assigned  a 
different  color  (orange)  in  the  color  display.  To automatically  fit  the  scale  to  the  whole 
dynamic range of the function, inside the window, right-click on the window, and select “Fit 
Semantic Scale → Fit Both” (or Fit Maximum or Fit Minimum). 


◦ Synchronize windows: In Paraver every timeline window represents a single metric (MPI call, 
useful  IPC,....)  for all  selected processes  and time span. It  is  possible to synchronize  two 
timelines by making them display the exact same processes and time span.  For doing so, just 
right-click  and  select  “Copy” on  the  source  (reference)  window  and  then  on  the  target 
window right-click and select “Paste → Size” and “Paste → Time”. Both windows will then 
be of the same size and  represent different views (metrics) for the same part of the trace. If 
you put one above the other there is a one to one correspondence between points in vertical. 
The “Paste Time” lets you copy only the time scale from the first window to the target one. 



cfgs/useful_IPC.cfg





The “Paste Semantic Scale” lets you apply to the target window the same vertical scale the 
source window had.


• Load the configuration  L2missratio.cfg.  This configuration file  shows a timeline with the L2 
cache miss ratio (L2 cache misses per 1000 instructions) in each interval between MPI events. 
You can observe that the L2 cache miss ratio is higher in the communication phases than in the 
long computation phases. The red triangle in the lower left corner warns that the Y scale is not  
enough to display the whole dynamic range of L2 cache miss ratios. This reflects in some areas 
appearing  as  orange  (above  the   Semantic  Minimum  value).  You  can  automatically  set  the 
Semantic Minimum and Maximum values to have a linear gradient display for the whole range by  
right-clicking and selecting “Fit Semantic Scale → Fit Both”. In this case the original semantic 
scale does show the difference between the computation phases. You can go back by manually 
changing the “Semantic Maximum” value in the Main Window to 0.5.


•  Load useful_duration.cfg. This configuration file shows a timeline where the color represents the 
duration of a computation burst between an exit form MPI and the next entry.  The function is 
valued to 0 (black) in the regions where processes are in MPI. This view gives a good perception  
of where are the major computation phases, and their balance across processors.


•  Load p2p_size.cfg to see the message sizes for each message sent along the time axis.


Profiles


The above analysis went directly to the detailed timeline, but a less detailed averaged statistic can often be  
sufficient to identify problems and gives a summarized view of the behavior of an application. Paraver  
provides  one  mechanism to  obtain  such  profiles  for  the  desired  region  of  a  trace.  We call  it  the  2D 
Analyzer as it is a very flexible mechanism to generate tables of summarized statistics.  Let's use it:


• Load configuration file mpi_stats.cfg. A table pops up with one row per thread and one column 
per MPI call. The first column corresponds to the time outside MPI. Each entry in the table tells 
the percentage of time the corresponding thread has been inside the specific call.


• To see  a  different  statistic  change  the  Statistic  selector in  the  Main  Window  (expand  the 
“Statistics” section in the “Window Properties”, if necessary). Interesting options at this time 
may be:
◦ Time: to get the accumulated   time each process has spent in each MPI call.
◦ #Bursts: To count the number of invocations to each call.
◦ Average Burst Time: to compute the average duration of the call.


•      All the above statistics are computed based on a single timeline window, which we call the 
“Control Window” and which can be popped up by clicking on the control window icon in the 
top left corner of the window. In this example, you will see that it is the same “MPI call” view we  
had loaded before.  The values of the control  window determine to which column is a given 
statistic accumulated/accounted.


• The statistic inside a cell can actually be performed on a different window, that we call the “Data 
Window”. For example, if you select the “Average Value” statistic and you select as the data 
window the “Instructions per cycle” window we loaded before, the entry will report the average 
IPC within the specific MPI call.  To change the Data Window, expand the “Data” section (if 
necessary) in the Main Window, and change the “Window” value by clicking on the value and 
selecting a window.  Change it back to the “MPI Call” window and to the %Time statistic.



cfgs/mpi_stats.cfg

cfgs/p2p_size.cfg

cfgs/useful_duration.cfg

cfgs/L2missratio.cfg





• To apply the analysis to a subset of the trace, zoom on any of the timelines to the time region you  
are interested on.  Right-click and select “Copy” on this window and right-click and select “Paste 
→ Time” on the table. The analysis will be repeated just for the selected time interval.


•     To  get  a  global  perception  of  the  profile  for  all  MPI  calls  and  processes  click  on  the 
magnifying glass at the top of the icons column on the right of the window. You can go back to 
the numerical display by clicking again on the icon.


• If you want to focus only on the actual MPI call columns (discarding the first column)  change  
the “Control Minimum” on the Main Window. If the whole table appears as green, you can 
rescale the gradient coloring scheme by right-clicking in the window and selecting “Autofit Data 
Gradient”.


• Load  2dp_MPIcallerLine.cfg.  This profile shows one column per source line from where an 
MPI call is made. It shows the average duration of the calls from that line. You can change the  
statistic to “% Time” to see the percentage of time spent at each calling line or to “#  Bursts” to  
see how many calls from that line were made.


• You can change the statistic to “Average Value” and the select the “p2p size” view as “Data” 
section of the Main Window. You will see which lines sent larger messages (the data window 
only reports the size of point to point messages).


• You can click on the “Open Control Window” icon on the top left corner of the Profile Window 
to show a time line of from where was MPI called. Right-click and use the “Info Panel” view to 
see the coloring encoding (on the “Colors” tab).


•     You can click on the “Open Filtered Control Window” icon from the top of the Profile 
Window, and then left-click and drag to select one or more columns in the 2D table. A timeline 
will be created showing when in time the different processes called MPI from that specific line. 


Histograms


The same mechanism used to compute profiles can be used to compute histograms. To get a histogram of 
continuous valued metrics:


•  Load configuration file 2dh_useful_duration.cfg. A table pops up with one row per thread. 
The X axis represents bins of a histogram. In this case, every pixel represents a bin of 2000 
microseconds (“Delta” value in the “Control” section of the Main Window). The pixels at 
the left  of the table represent  very short  durations,  those at  the right represent  very large 
duration.  Every  pixel  is  colored  with  the  percentage  of  time  that  process  spent  in  a  
computation phase of the length corresponding to the pixel column. The color encoding is  
light green for a low percentage, dark blue for a high percentage (low and high are defined by 
the Minimum and Maximum values in the “Control” section of the Main Window).


•  Ideally on a balanced SPMD application you would expect vertical lines, representing the 
different computation bursts are of exactly the same duration for all processes. You can see 
that in this example theres is a certain variance between processors (vertical bands rather than 
lines).


•  If you move the cursor over the colored pixels, the bottom of the window will show the 
actual range represented by the column of the pixel and the actual value (percentage in this 
case) for that pixel.



cfgs/2dh_useful_duration.cfg

cfgs/2dp_MPIcallerLine.cfg





•  If you want to see the numerical values of the table click on the magnifying glass at the top of 
the column of icons at the right of the window. You will see the individual columns, for each  
of the the range of durations it represents is show at the top.


•  It is possible to change the statistic so that the actual value represented is total time, average  
duration of the bursts or average value of other metric (such as “IPC”). For example, in the  
“Statistics” section of the Main Window, you can change the statistic selector to “Average 
value” and select “Instructions Per Cycle” as the data window. You can change the range of 
the coloring scheme in the Statistics Minimum and Maximum fields in the Main Window. For 
example, if you put a 0.7 in the “Minimum Gradient Statistics” field in the Main Window,  
you will be able to clearly differentiate regions with less than that IPC (light orange), regions  
just above 0.7 IPC (light green) and regions close to the Max IPC (dark blue, 0.9 in this case).  
This mechanism is very useful to analyze correlations between metrics. You will directly get  
this view by loading 2dc_ud_ipc.cfg.


•  The  histogram  on  instructions  correlated  to  cache  misses  can  be  seen  by  loading 
2dc_I_L2mr.cfg. In this histogram of instructions  (columns now represent bins of number 
of instructions executed in a computation burst between MPI calls). You can see that there are  
also  some  vertical  bands  indicating  that  there  is  actually  computational  load  imbalance. 
Curiously,  the vertical bands are not equally separated in the instruction histogram and the  
duration histogram, corresponding to variations in IPC.


•  If you load  3dh_msgsize_p2pcall.cfg, the histogram is now of the message size in point to 
point calls. This window actually shows the histogram for a specific MPI call, MPI_Isend in 
this case as shown at the “3D” section of the Main Window. The Statistic (color) represented 
is the number of messages of that size sent. You can see that there are more small than large 
messages.


• You can change the “Plane” selector in the “3D” section of the Main Window to see the 
histogram of message sizes for a different MPI call.



cfgs/3dh_msgsize_p2pcall.cfg

cfgs/2dc_I_L2mr.cfg

cfgs/2dc_ud_ipc.cfg










Guided demo MPI analysis:


• Load trace mpi/HydroC_mpi64.prv.gz 


• Load configuration file cfgs/mpi/mpi_stats.cfg


• This configuration pops up a table with %time of every thread spends in every 
MPI call.


• Look at the global statistics at the bottom of the outside mpi column. Entry 
Average represents the application parallel efficiency, entry Avg/Max represents 
the global load balance, entry Maximum represents the communication efficiency.


• Change in the main window the metric to nb of calls to look at the number of 
invocations and Average duration to look at the average duration of each MPI call


• Open the Control Window from the table (top left button). Use the zoom and 
contextual menu (right click) to navigate, view communications lines... 


• Load configuration file cfgs/mpi/user_functions.cfg.


• This configuration pops up a timeline where every color corresponds to one of the 
instrumented user functions,


• Zoom to identify one iteration and synchronize the interval with the MPI call 
timeline using the Copy and Paste commands.


• Double click on one color over the timeline to open the textual display of the 
actual function name and duration. Use the menu option Info Panel to hide it 
again.


• Create a table showing the default statistic (Time) accumulated per user function.


• Load configuration file cfgs/mpi/2dh_usefulduration.cfg


• This configuration shows a histogram of the duration for the computation regions. 
The computation regions are delimited by the exit from an MPI call and the entry 
to the next call.


• Using the Open Filtered Control Window button select one of the histogram 
modes, this will create a new timeline with the selected duration range. Use the 
Fit Semantic Scale →Fit Both option to set the gradient color such that it fits the 
actual range of durations in the new window.


• Modify the Statistics of the useful duration histogram to use the correlate with 
metric and verify that the metric wiindow is Instructions per cycle. Now the cell 



file:///home/judit/tutorial/wxparaver/mpi/HydroC_mpi64.prv.gz

file:///home/judit/tutorial/wxparaver/cfgs/mpi/2dh_usefulduration.cfg
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file:///home/judit/tutorial/wxparaver/cfgs/mpi/mpi_stats.cfg





color will correspond to the IPC showing the correlation between duration 
(position) and IPC (color). Zoom into an unbalanced mode to verify if the 
unbalance is related to a different IPC.


• Load configuration file cfgs/mpi/2dh_useful_instructions.cfg


• This configuration pops up a histogram of the instructions on the computing 
regions (outside MPI).


• Copy the scale of one iteration from the useful duration timeline to this new 
histogram. Vertical lines identify well balanced regions with respect to the number 
of instructions.


Futher questions:


Paraver profile analyses


• Load configuration file cfgs/mpi/2dp_uf_several_stats_numbers.cfg Study the 


three different profiles. What do they compute (control window, statistic, data window)?


• Are all routines equally balanced in terms of time?


• Are all routines equally balanced in terms of instructions? Any of them is worse 
balanced?


• Do all routines achieve the same IPC. Which seem to have bad IPC?


• Check if L2 miss ratio is a possible cause of the observed poor IPCs 
(cfgs/mpi/L2D_miss_ratio.cfg displays the number of L2D misses per 1kinstr). 


Hint: clone the 2DP-uf-IPC profile and change data window.


• Routine equation of state:


• Average duration per call? Is the granularity enough to parallelize with OpenMP, 
GPU?


• How many invocations?


• Routine riemann:


• Average duration?


• Average IPC? 


• Which routines call MPI and which not? Use cfgs/mpi/2dp_uf_percentMPI.cfg. 


• Scaling: Load also trace of 128 processes (mpi/HydroC_mpi128.prv.gz) and cfgs/
mpi/2dp_uf_several_stats_numbers.cfg



file:///home/judit/tutorial/wxparaver/cfgs/mpi/2dp_uf_several_stats_numbers.cfg
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• Pop up and synchronize the user functions views. Does it scale well?


• Which routines scale well or bad? (η=T64/2*T128)


• Do they scale well in terms of number of instructions?


Paraver histogram analyses


• Load cfgs/mpi/3dh_several_uf.cfg


• Routine UpdateConservativeVars


• Imbalanced? Multimodal distribution? 


• Which instances take more time and which less?


• Is it due to differences in the number of instructions? 


• Routine equation_of_state


• Are all the invocations of the same duration?


• Is there a pattern?


• Reason for difference between them?


• Routine riemann:


• All invocations of the same duration? Multimodal? Reason?


• Is the distribution similar at 64 and 128 processes?


• Routine make boundary


• What is its average IPC? What is the average IPC of the computation outside 
MPI? Why are they so different?



file:///home/judit/tutorial/wxparaver/cfgs/mpi/3dh_several_uf.cfg





Guided demo Dimemas analysis:


• In directory Dimemas we have prepared:


• The original HydroC_mpi64.prv.gz and its translation to the Dimemas format 
HydroC_mpi64.trf


• Dimemas configuration files and the corresponding traces generated by the 
Dimemas simulation for:


• dimemas_files/64.nominal.cfg: a “nominal” setup: 8 


processes per node, one adapter per node, 1GB/s, no network 
contention. D.64.nominal.prv.gz


• dimemas_files/64.10xCPUr.cfg: assuming 10x faster CPU 


for all computations. D.64.10xCPUr.prv.gz


• dimemas_files/64.10xCPUr.1xEOS.cfg: assuming 10x 


faster CPU except for routine equation_of_service that is assumed 
to stay equal. D.64.10xCPUr.1xEOS.prv.gz


• dimemas_files/64.10xCPUr.0.1xEOS.cfg: Assuming 10x 


faster CPU except for routine equation_of_service that is assumed 
to actually slow down by 10x due to parallelization overheads. 
D.64.10xCPUr.0.1xEOS.prv.gz


• Load the configuration file cfgs/mpi/user_functions.cfg on each of them. The 
loaded views will show the structure and relative impact of the different regions in the 
total time of each case. Copy the time scale from the original trace to each other trace to 
compare global scalability.


Further Dimemas analysis


• A similar process can be done using configuration files:


• dimemas_files/64.ideal.cfg: An “ideal” setup with instantaneous communication. 
D.64.ideal.prv.gz


• dimemas_files/64.NxCPUr.MBW.cfg: configuration of hypothetical target machine 
with N times faster CPUs and M (0.1 and 0.01) times the original bandwidth. 
D.64.100xCPUr.prv.gz, D.64.100xCPUr.0.1xBW.prv.gz, 
D.64.100xCPUr.0.01xBW.prv.gz
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file:///home/judit/tutorial/wxparaver/Dimemas/D.64.100xCPUr.prv.gz

file:///home/judit/tutorial/wxparaver/Dimemas/D.64.ideal.prv.gz

file:///home/judit/tutorial/wxparaver/cfgs/mpi/user_functions.cfg

file:///home/judit/tutorial/wxparaver/Dimemas/D.64.10xCPUr.0.1xEOS.prv.gz

file:///home/judit/tutorial/wxparaver/Dimemas/D.64.10xCPUr.1xEOS.prv.gz

file:///home/judit/tutorial/wxparaver/Dimemas/D.64.10xCPUr.prv.gz

file:///home/judit/tutorial/wxparaver/Dimemas/D.64.nominal.prv.gz

file:///home/judit/tutorial/wxparaver/Dimemas/HydroC_mpi64.prv.gz





Guided demo MPI+CUDA analysis:


• Load trace mpi+cuda/cuHydro_mpi32.filter1.prv.gz


• This tracefile contains only the MPI calls, user function and “large” computing 
burst from the MPI+CUDA execution. It has been obtained from the original trace 
with the filtering utilities in Paraver.


• Load configuration files mpi/mpi_stats.cfg and mpi/user_functions.cfg


• Use them to compare the execution of the MPI and the MPI+CUDA version. 
Compare the structure within one of the iterations on the two versions.


• Load trace mpi+cuda/cuHydro_mpi32.chop1.prv.gz


• This tracefile contains approximately a chop of one of the double iterations.. It has 
been obtained from the original trace with the cutting utilities in Paraver.


• Load configuration files cfgs/mpi+cuda/3dp_cudakernel_uf.cfg and 
cfgs/mpi+cuda/cuda_events.cfg


• The first configuration shows a profile of the number of cuda kernel invocations by 
each user function. Use the 3D – Plane chooser in the general Paraver window to 
select a different user function.


• The second configuration shows the CUDA runtime events instrumented.


• Use the zoom into a small area (control+select area) in one of them and 
synchronize all the timelines (Copy and Paste Default Special).


Further CUDA analysis


• Load the configurations cfgs/mpi+cuda/2dp_cudakernel.cfg and 
mpi/2dp_uf.cfg


• What is the average duration of the different kernels? And user functions?


• How many invocations of the different kernels appear? And user functions? 


• Pop up the view cuda events and zoom to show just the two lines corresponding to 
process 1. Use Paste Default Special to see the exact same region and objects in the 
cuda kernel view.


• Look for the cuRiemann function invocations.



file:///home/judit/tutorial/wxparaver/cfgs/mpi/2dp_uf.cfg

file:///home/judit/tutorial/wxparaver/cfgs/mpi+cuda/2dp_cudakernel.cfg

file:///home/judit/tutorial/wxparaver/cfgs/mpi+cuda/cuda_events.cfg

file:///home/judit/tutorial/wxparaver/cfgs/mpi+cuda/3dp_cudakernel_uf.cfg

file:///home/judit/tutorial/wxparaver/mpi+cuda/cuHydro_mpi32.chop1.prv.gz

file:///home/judit/tutorial/wxparaver/cfgs/mpi/user_functions.cfg

file:///home/judit/tutorial/wxparaver/cfgs/mpi/mpi_stats.cfg

file:///home/judit/tutorial/wxparaver/mpi+cuda/cuHydro_mpi32.filter1.prv.gz





• How many Kernel invocations per cuRiemann function are done? How long do 
they take? Is the overhead relevant? Is the GPU speed-up versus the sequential 
code good for this routine?


• Look for the cuEquationOfState function


• How many Kernel invocations to the cuEquationOfState function are done? How 
long do they take? Is the same all over the trace? Is the overhead relevant?
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Sequential heat diffusion
program


In this document we guide you thorough the analysis of potential task decom-
positions for the three solvers available in a sequential code that solvers the
heat equation. The code simulates the diffusion of heat in a solid body using
several solvers for the equation (Jacobi, Red–Black and Gauss–Seidel). Each
solver has different numerical properties which are not relevant for the purposes
of this laboratory assignment; we use them because they show different parallel
behaviors.


The picture below shows the resulting heat distribution when a single heat
source is placed in the lower right corner. The program is executed with a
configuration file (test.dat) that specifies the size of the body, the maximum
number of simulation steps, the solver to be used and the heat sources. The
program generates performance measurements and a file heat.ppm providing
the solution as image (as portable pixmap file format).


Figure 1.1: Image representing the temperature in each point of the 2D solid
body


1. Login into the Minotauro machine at the Barcelona Supercomputing Cen-
ter (BSC-CNS). To do that open a terminal window in your laptop and
connect to Minotauro using the login credentials already sent to you by
Email. Copy the tarball with all files needed to do this laboratory session
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from /home/nct/nct00001/heat.tar.gz in Minotauro and uncompress
it. Go into the heat directory generated and source the environment.bash
file to appropriately define paths and environment variables ("source
./environment.bash").


2. Go into the tareador directory. Compile the sequential version of the
program using "make heat" and execute the binary generated ("./heat
test.dat"). The execution reports the execution time, the number of
floating point operations (Flop) performed, the average number of float-
ing point operations performed per second (Flop/s), the residual and the
number of simulation steps performed to reach that residual. Visualize the
image file generated with an image viewer (e.g. "eog heat.ppm") and save
it for validation purposes with a different name, e.g. heat-jacobi.ppm.


3. You can change the solver from Jacobi to Red-Black and to Gauss-Seidel
by editing the configuration file provided (test.dat). The result files
generated when using different solvers are slightly different; rename the
.ppm files so that you can use them later to check the correctness of the
parallel versions you will program.


3







2


Analysis with Tareador


Next we will use Tareador to analyze the potential parallelism that we can
achieve for the three different solvers. We already provide you with an incom-
plete instrumented version for the Jacobi ; take a look at the instrumentation
performed in order to identify the parallel tasks we are proposing.


1. Compile the initially proposed task decomposition using "make heat-tareador".
Execute the "run tareador.sh" script to run the binary generated (using
"./run tareador heat-tareador small.dat"). Notice that we are us-
ing the small.dat as the configuration file for the Tareador instrumented
executions (which just performs one iteration on a very small image). The
script will open a new window to display the task graph obtained from
the instrumented execution.


2. Which accesses to variables are causing the serialization of all the tasks
when using the Jacobi solver? If you were able to protect them, what
would be the task graph that would be generated? Insert the calls to
tareador disable object and tareador enable object in the source
code and obtain the new task graph. Are you increasing the parallelism?
Have you obtained the task graph you were expecting?


3. Simulate the parallel execution by executing the run dimemas.sh script,
in which you will have to specify the name of the instrumented binary
(heat-tareador) and the number of processors you want to simulate, for
example 1, 2, 4, 8 and 16. The simulation opens a couple of Paraver win-
dows: one showing a timeline with the execution of the tasks and another
one with the parallelism profile. The same colors used in the graph are
used now to display the temporal execution of the tasks. On the bottom-
right corner you have the execution time as simulated by Dimemas.


4. Do a table in which you show the simulated execution time and speedup
(from 1 to 16 processors, with respect to the execution with one processor)
for the Jacobi solver.


5. After analyzing the simulated executions, do you think there are other
parts of the code involved in the execution of the Jacobi solver that can
be decomposed into tasks? Instrument the code to create these new tasks
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and repeat the process, adding a new column to the previous table for the
new simulated results.


6. Repeat the previous steps for the Red–Black solver. When using the
Red-Black solver, which accesses to variables are causing the dependences
among Red tasks, among Black tasks, and among Red and Black tasks?
Complete the previous tables with the simulated execution times and the
speed-up achieved with Red–Black.


7. Repeat the previous steps for the Gauss–Seidel solver. Identify the causes
for the dependences that appear when using the Gauss-Seidel solver.
Complete the previous table with the simulated execution times and the
speed-up achieved with Gauss–Seidel.
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Shared–memory
parallelization with OpenMP


In this section we will guide you through the parallelization of the heat diffu-
sion sequential code using the OpenMP shared-memory paradigm, following the
geometric block decomposition suggested in Figure 3.1. Go into the openmp


directory.


bx 


by 


sizex 


sizey 


thread0 


thread1 


thread2 


thread3 


nbx=num_threads 


Figure 3.1: Geometric decomposition for matrix u (and utmp) in blocks


Due to the increasing complexity of the parallelization, we recommend that you
start with the parallelization of the Jacobi solver using the heat-omp.c and
solver-omp.c files that we provide you, and that you follow these steps:


1. Parallelize the Jacobi solver by inserting the appropriate OpenMP pragmas
to create threads, distribute work among them and perform the necessary
synchronization.


• Compile using "make heatomp" and execute with a certain number
(power of 2) of OpenMP threads (e.g. "OMP NUM THREADS=4 ./heatomp


test.dat"). Validate the parallelization by visually inspecting the
image generated and making a diff with the file generated with the
original sequential version.
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• Submit the submit-omp.sh script (using "mnsubmit submit-omp.sh")
to execute the binary in the queue system (the usual procedure
in the production machine). The script executes the parallel ver-
sion using from 2 to 12 processors. You can check the status of
your job by doing mnq1. The execution generates two files with
the standard output (heatomp.<job id>.out) and standard error
(heatomp.<job id>.err). Draw a plot or do a table with the speed-
up that is achieved. Is the scalability appropriate?


• Instrument the parallel code using Extrae and visualize the execution
with Paraver. To do that, just submit the submit-extrae.sh script,
look at the trace files generated and open with wxparaver. The
instrumentation is done with 8 threads, but you can change this
number if necessary.


• Parallelize other parts of the code, or simply rewrite them in a differ-
ent way, in order to improve the parallel performance. Complete the
previous speed-up plot or table with the results obtained with your
new version.


2. Do a table in which you show the parallel execution time and speedup
(from 1 to 8 processors, with respect to the serial execution time) for the
Jacobi solver.


3. Repeat the steps in the previous bullet with the parallelization of the Red–
Black and the Gauss–Seidel solvers, completing the previous table with
the parallel execution time and speedup for them.


1In case you need to remove a job from the execution queue, just use "mncancel <job id>".
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